
Manual > Payment on Voluntary Basis (FORM GST DRC-03)
How can I make payment against the liability (tax, interest, penalty and others) based on self-ascertainment of tax?

To make payment against the liability (tax, interest and penalty) based on self-ascertainment of tax, perform following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed. Login to the GST Portal with valid credentials. Click the Services > User Services > My Applications
option.
 

 
2. Select the Intimation of Voluntary Payment - DRC - 03 from the Application Type drop-down list. Click the NEW APPLICATION button.
 



 
3. The Intimation of payment made voluntarily or made against the show cause notice (SCN) page is displayed.
Note: Application for intimation of voluntary payment can be saved at any stage of completion for a maximum time period of 15 days. If the same is not filed within 15 days, the
saved draft will be purged from the GST database. To view your saved application, navigate to Services > User Services > My Saved Applications option.
 



 
4. Select the Cause of Payment from the drop-down list.
 

 
4.1 In Case of Voluntary Payment
Payment date is auto-populated and cannot be edited.
 



 
4.2 In Case of SCN
a. Select Manual Entry from the SCN Reference Number drop-down list and enter the SCN Reference Number.
b. Select the SCN Issue Date using the calendar.
Note: SCN Issue date should be within last 30 days.
 

 
4.3 In Case of Annual Return
 

 
4.4 In Case of Reconciliation Statement
 



 
5. Select the Section Number from the drop-down list.
 

 
6. Select the Financial Year and From date and To Date for Overall tax Period from the drop-down list.
7. Enter the Details of payment made including interest, penalty and others.
 





 
8. Use the scroll bar to move to the right to enter more details.
Note: You can click the DELETE or ADD button to delete or add more payment details.
9. Click the PROCEED TO PAY button.
 



 



The Voluntary Payment page is displayed.
 





 
10.1 Liability Details
Liability details are displayed as shown in below table.
 

 
10.2 Cash Ledger Balance



The cash available as on date are shown in below table.
Note: Interest and penalty amount shall be paid out of cash ledger only.
 

 
10.2.1 Use the scroll bar to move to the right to enter the amount to be paid through cash against the liability.
 



 
10.2.2 Use the scroll bar to move to the right to enter the amount to be paid through cash by creating challan against the liability.
 



 
10.3 Credit Ledger Balance
The ITC available as on date are shown in below table.
 





 
10.3.1 Use the scroll bar to move to the right to enter the amount to be paid through ITC against the liability.
 







 
11. Select the Verification checkbox and enter the Name of Authorized Signatory and Place. Click the CREATE CHALLAN button.
 

 
11.1 The Create Challan page is displayed. In the Tax Liability details grid, the Total Challan Amount field and Total Challan Amount (In Words) fields are auto-populated with
total amount of payment to be made. You cannot edit this amount.
 





 
11.2. Select the Payment Modes as E-Payment/ Over the Counter/ NEFT/RTGS. Click the GENERATE CHALLAN button.
 



 
11.3. The Challan is generated.
 



 
Note: 
In case of Net Banking: You will be directed to the Net Banking page of the selected Bank. The payment amount is shown at the Bank’s website.
In case of successful payment, you will be re-directed to the GST Portal where the transaction status will be displayed.
 
In case of Over the Counter:



Take a print out of the Challan and visit the selected Bank. Pay using Cash/ Cheque/ Demand Draft within the Challan’s validity period. Status of the payment will be updated on
the GST Portal after confirmation from the Bank.
 
In case of NEFT/ RTGS:
Take a print out of the Challan and visit the selected Bank. Mandate form will be generated simultaneously. Pay using Cheque or through your account with the selected Bank/
Branch. You can also pay using the account debit facility. The transaction will be processed by the Bank and RBI shall confirm the same within <2 hours>. Status of the payment
will be updated on the GST Portal after confirmation from the Bank.
 
Click here to refer the FAQs and User Manual on Making Payment.
 
12. A payment successfully completed message is displayed. The Bank Transaction ID is displayed on the screen. Click CONTINUE.
 

https://www.gst.gov.in/help/payments


 
18. Click the PREVIEW button to preview the draft in PDF format.
 





 
19. The draft statement in PDF format is downloaded on your computer. You can open the file to view details.
 



 
20. Before filing, In the Reasons if any field, enter the reasons.
21. Click the Choose File button to upload any document.
Note:

File with PDF or JPEG format is only allowed

Maximum 4 files and 5 MB for each file allowed

22. Select the Verification checkbox.
23. Select the Name of Authorized Signatory from the drop-down list.



24. In the Place field, enter the place where form is filled.
25. Click the FILE button.
 





 
A confirmation message is displayed. Click OK to continue.
 

 
26. Click the FILE WITH DSC or FILE WITH EVC button  
 



 
26.1 FILE WITH DSC:
a. Select the certificate and click the SIGN button.
 
26.2 FILE WITH EVC:
a.  Enter the OTP sent on the e-mail and mobile phone number of the Authorized Signatory registered at the GST Portal, and click the VALIDATE OTP button.
 



 
27. The success message is displayed. ARN is generated and displayed. SMS and email will be sent to the taxpayer intimating ARN and successful filing of the Form.
Note:

To download the submitted application, click the Click here link.

You can click the CREATE NEW APPLICATION button to create a new application for making payment.

 



 



Manual > Applying for Deferred Payment/Payment in Instalments (FORM
GST DRC-20)
How can I file an application for deferred payment or payment in instalments of amount due under the GST Act and follow
it up on the subsequent proceedings?

To file an application for deferred payment or payment in instalments of amount due under the GST Act and follow it up on the subsequent proceedings, perform following steps:
A. File an Application for deferred payment or payment in instalments
B. Open the Application's Case Details screen by searching for your filed Application in My Applications page or from View Additional Notices/Orders page
C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application
D. Take action using ORDERS tab of Case Details screen: View the Order issued on that Application
E. View Instalment Calendar
 
Click each hyperlink above to know more.

A. File an Application for Deferred Payment or Payment in Instalments

To file an Application for Rectification of Order, perform following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications  
 

https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_my_applications.htm
https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_additional_notice_and_order.htm
http://www.gst.gov.in/


 
4. My Applications page is displayed. In the Application Type field, select "Application for Deferred Payment/Payment in Instalments" and then click the NEW APPLICATION
button.
 



 
5. New Application page is displayed. Enter details in the displayed fields as mentioned in the following steps.
 





 



Note: Alternatively, you can access this application form from the following navigation: Dashboard > Services > Payments > Application for Deferred Payment/Payment in
Instalments  
 

 
5a. In the Demand ID field, enter the demand id and click the SEARCH button. Details of the outstanding demand against the Demand ID gets displayed below the SEARCH field.
Also, Tax Period fields below get auto-populated.
 



 
5b. In Type of Payment field, choose one of the two radio buttons against Monthly Instalments or Deferred Payment options.
 



 
5b. i. If you select the radio button against the Monthly Instalments option, its field appears. Enter the number of months and click the CALCULATE button. This will auto-
calculate and display the Expected Monthly Instalment table. Also, note the message below the expected monthly instalment table that mentions the per annum interest rate
which will be charged on the Tax/Cess amount.
 



 
Note: Maximum no of Installment allowed is 24.
 
5b. ii. If you select the radio buttons against the Deferred Payment option, its field appears. Select your preferred Due date of payment from the calendar.
 



 
5c. In the Enter Document Description field, enter brief description of the document, if any, you wish to upload along with this application. Then, click Choose File to upload
those document(s). This is not a mandatory field.
 

 
5d. In the Reasons field, if required, enter details about why you are filing this application. This is not a mandatory field.
 



 
5e. Enter Verification details. The Date field is auto-populated based on the current system date. Select the declaration check-box and the name of the authorized signatory.
Based on your selection, the field Designation/Status displayed below gets auto-populated. Enter the name of the place from where you are filing this application.
 

 
5e. Click PREVIEW to download and review your application.
 



 
5f. Once you are satisfied, click SUBMIT.
 



 
6. Submit Application page is displayed. Click ISSUE WITH DSC or ISSUE WITH EVC.
 



 
7. Provisional Acknowledgement page is displayed. You will also receive an SMS and email intimating you of the generated ARN and successful filing of the application. To
download the filed application, click the DOWNLOAD button or click Go To My Applications link go back to My Applications page.
 



 
Note: Once the application is filed, Status of the application gets updated to "Pending for Processing".
 
8. Additionally, following actions will take place on the GST Portal:
 

Your application for payment in Installments will be submitted to the Commissioner of concerned jurisdictional authority and will become a pending item in his/her queue of

work-items. The Officer will adjudicate on the application and either Approve or Reject your request. You can access the generated ARN and view the filed application from the
following navigation: Dashboard > Services > User Services > My Applications > Case Details > APPLICATIONS
Demand ID in DCR, in respect of which you have filed this application, will be flagged to show that such an application is filed against the Demand ID.

 
Go back to the Main Menu



C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

To view Application Details based on which this Case was created, perform following steps:
 

1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not selected by default. This tab provides you an option to view the filed

application, along with its supporting documents in PDF mode. Click BACK to go back to My Applications page.

 

 
2. Click the documents in the "Action" column to download and view them.
3. Click BACK to go back to My Applications page.
 
Go back to the Main Menu

D. Take action using ORDERS tab of Case Details screen: View the Order Issued on that Application

To view and download the order issued against your application, perform following steps:
 
1. On the Case Details page of that particular taxpayer, click the ORDERS tab. This tab provides you an option to view the issued order, with all its attached documents, in PDF
mode.
 



 
Click BACK to go back to My Applications page.
 
2. Click the View hyperlink in the "Action" column to download and view the issued Order.
 
Note 1:

Status of this ARN/Case is "Rejected" as the Officer has rejected this application request.

Status of ARN shall get updated to "Approved" in case of acceptance and “Application approved with modification” in case of modification.

 
Note 2:  
 
Once the officer has processed an application for deferred/payment in Instalments, following actions will take place on the GST Portal:
 

Approval or Rejection or Modification order will be generated and intimation of issue of order shall be sent via email and SMS to taxpayer.

Status of ARN shall get updated to ‘Rejected’ in case of rejection, "Approved" in case of acceptance and “Application approved with modification” in case of modification.

Order will be available at the dashboard of taxpayer for view, print and download: Dashboard > Services > User Services > My Applications > Case Details > ORDERS  

Status of Recovery ID remains the same in case of rejection. In case of acceptance or modification, the status of recovery ID shall change to “Deferred Payment/Payment by

Instalments”. If there is a default in the payment of monthly instalments, the status of recovery ID shall change from Deferred Payment/Payment by Instalments to Recoverable
 
Go back to the Main Menu



E. View Instalment Calendar

Instalment table displays the taxpayer's instalment details to be paid by him along with status of payments.
 
To view the instalment calendar, perform following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Services > Payments > Instalment Calendar.
 

 
4. The Instalment Calendar search page is displayed.
5. Enter the Demand ID.
6. Click the SUBMIT button.
 

http://www.gst.gov.in/


 
7. The Instalment Calendar page is displayed.
 





 
8. Click the major head hyperlink to view minor head details.
 

 
9. The details are displayed.
10. Click the Close button.
 



 
Go back to the Main Menu



Manual > Filing reply to Form GST DRC-22, against proceedings initiated for
Recovery of Taxes
The Tax Official has issued Form GST DRC-22, to the concerned authorities for provisional attachment of my property,
bank accounts, etc . How can I file reply to Form GST DRC-22 against proceedings initiated against me?

To file reply to Form GST DRC-22 against proceedings initiated against you by Tax Officer, for recovery of taxes by attaching your property, perform following steps:
 
A. Navigate to View Additional Notices/Orders page to view Notices and Orders issued against you by Tax Official
B. Take action using RECOVERY DETAILS tab of Case Details screen: View Recovery Details
C. Take action using NOTICES tab of Case Details screen: View issued Notices
D. Take action using REPLIES tab of Case Details screen:  View/Add your reply to the issued Notice
E. Take action using CERTIFICATES/ ORDERS tab of Case Details screen: View issued Order or Certificate

 
Click each hyperlink above to know more.

B. Take action usingRECOVERY DETAILS tab of Case Details screen: View Recovery Details

To view the recovery details, perform following steps:
 
1. Navigate to Services > User Services > View Additional Notices/Orders option.
 

https://tutorial.gst.gov.in/userguide/taxpayersdashboard/index.htm#t=manual_additional_notice_and_order.htm


 
2. Click View.
 



 
3.  On the Case Details page of that particular taxpayer, select the RECOVERY DETAILS tab, if it is not selected by default. This tab displays all the details of demand issued and
mode of recovery.
 



 
Go back to the Main Menu

C. Take action usingNOTICES tab of Case Details screen: View issued Notices

To view issued notices by the Tax Official, perform following steps:
 
1.  On the Case Details page of that particular taxpayer, select the NOTICES tab, if it is not selected by default. This tab displays all the notices issued by the Tax Official.
2. Click the View link in the Action column of the table to download notices issued into your machine and view them.
 



 
Go back to the Main Menu

REPLIES tab of Case Details screen: View/Add your reply to the issued NoticeD. Take action using

To view or add your reply to the to Form GST DRC-22, perform following steps:
 
1. On the Case Details page of that particular taxpayer, select the REPLIES tab. This tab will display the replies you will file against the Notices issued by the Tax Official. To add a
reply, click ADD REPLY.
 



 
2. The REPLY page is displayed.
 



 
3. Select the Mode of Recovery, Notice Type and Notice Reference Number from the drop-down list.



4. Click Choose File to upload your reply and upload any supporting document(s) related to your reply, if any.
5. Select the Verification check-box and select the name of the authorized signatory.
6. Enter the Place where the form is filed.
7. Click SUBMIT.
 



 
8. Click PROCEED.
 



 
9. Submit Application page is displayed. Click ISSUE WITH DSC or ISSUE WITH EVC.
 

 
10. A success message is displayed with the generated Reference number. Click OK.
 

 



11. The updated REPLIES tab is displayed, with the record of the filed reply in a table. You can also click the documents in the Action section of the table to download them.
 

 
Note: Once you file your reply successfully, following actions take place on the GST Portal:

You will receive an acknowledgement intimation via your registered email and SMS, along with the generated RFN.

Your reply will be available on Tax Official's dashboard.

 
Go back to the Main Menu

CERTIFICATES/ E. Take action usingORDERS tab of Case Details screen: View Order Issued against Your Case

To download order issued against your case, perform following steps:
 
1. On the Case Details page of that particular taxpayer, click the CERTIFICATES / ORDERS tab. This tab provides you an option to view the issued order or certificate, with all its
attached documents, in PDF mode.

2. Click the View link in the Action column of the table to download and view them.  

 



 
Go back to the Main Menu



Manual > Viewing Pre-GST Demand Uploaded by Tax Official (Form GST
DRC-07A & Form GST DRC-08A)
How can I view pre-GST demand uploaded by Tax Official?

To view pre-GST demand (Form GST DRC-07A & Form GST DRC-08A) uploaded by Tax Official, perform following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed. Login to the portal with valid credentials. Click Dashboard > Services > User Services > View Additional
Notices/Orders.
 

 
2. Additional Notices and Orders page is displayed. All orders/notices are displayed in descending order of date. You can search for the orders/notices you want to view using
the Navigation buttons provided. Click the View hyperlink to go to the Case Details screen of the issued Notice/Order.
 

http://www.gst.gov.in/


 
3. Case Details page is displayed. In that page, select the DRC-07A tab, if it is not selected by default. This tab displays the Form GST DRC-07A issued by Tax Official. Click
the hyperlink/s in the Documents section of the table to download and view them.

 
4. Order copy is displayed in PDF format.
 





 
Note: The summary of pre-GST demand will be issued/uploaded in Form GST DRC-07A by Recovery officer on the GST Portal and the demand will be posted in Part II of
Electronic Liability Register of the taxpayer. A sample screenshot is provided below.
 



 
5. Select the DRC-08A tab, if it is not selected by default. This tab displays the Form GST DRC-08A issued by Tax Official. Click the hyperlink/s in the Documents section of
the table to download and view them.
 



 
6. Order copy is displayed in PDF format.
 





 
Note: The summary of pre-GST demand will be issued/uploaded in Form GST DRC-08A by Recovery officer on the GST Portal and the demand will be posted in Part II of
Electronic Liability Register of the taxpayer. A sample screenshot is provided below.
 

 
7. To make payment against the pre-GST demand issued by Tax Official, navigate to Services > Ledgers > Payment towards Demand option.
Click here to know more about Payments towards Demand option.
 

https://tutorial.gst.gov.in/userguide/ledgers/index.htm#t=UtilizingCashmanual.htm


Manual > Viewing Prosecution Notice Issued by Tax Officials
How can I view Prosecution Notice issued by Tax Officials against my case?

To view Prosecution Notice issued by Tax Officials against your case, perform the following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > View Additional Notices/Orders   
 

 

http://www.gst.gov.in/


4. Additional Notices and Orders page is displayed. Click the View hyperlink to go to the Case Details screen of the issued Notice/Order.
 
Note: All orders/notices are displayed in descending order. You can search for the orders/notices you want to view using the Navigation buttons provided below.
 

 
5. Case Details page is displayed. The NOTICES tab is selected by default, where the table containing details of the Prosecution Notice is displayed. Click the document name(s)
in the Documents section of the table to download into your machine and view them.
 



 
Note: Once the Tax Official has issued Notice against your case, Status will be "Complaint filed". It will get changed to "Closed" when the Tax Official closes the case in any of the
following cases:

If you file the application for compounding of offence and the same is allowed by the Commissioner and the compounding amount (tax, interest and penalty involved) is

also paid by you within the time specified in the Order, then the private complaint filed with the First Class Judicial Magistrate or Competent Court will be withdrawn/stand
abated. (for details refer Section 138)

If you file the application for compounding of offence and the same is allowed by the Commissioner and the compounding amount is paid by you within the time specified in

the Order, but the private complaint is not yet filed with the First Class Judicial Magistrate or Competent Court, then no further action shall be taken for prosecution in
respect of same offence.

If the private complaint filed with the First Class Judicial Magistrate or Competent Court is set aside, then the case stands closed.

If you have complied with the order of the First Class Judicial Magistrate or Competent Court, then the case stands closed.

 
Go back to the Main Menu
 



Manual > Filing Application for Compounding of Offence (Form GST CPD-01)
and Taking Actions in the Subsequent Proceedings
How can I file Application for Compounding of Offence (Form GST CPD-01) and take subsequent actions?

To file Application for Compounding of Offence (Form GST CPD-01) and take subsequent actions, perform following steps:
 
A. File an Application for Compounding of Offence (Form GST CPD-01)
B. Open the Application's Case Details screen by searching for your filed Application in "My Applications" screen
C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application
D. Take action using NOTICES tab of Case Details screen:
D(1). View issued Notices
D(2). File Reply to the issued Notices
E. Take action using REPLIES tab of Case Details screen:
E(1) View Filed Replies
E(2) File Counter-replies
F. Take action using ORDERS tab of Case Details screen:
F(1). View the Order issued on that Application
F(2). Pay Compounding Fee
F(3). Initiate Rectification
G. Take action using RECTIFICATION tab of Case Details screen: View the filed Rectification Applications
 
Click each hyperlink above to know more.

A. File an Application for Compounding of Offence (Form GST CPD-01)

To file an Application for Compounding of Offence (Form GST CPD-01), perform following steps:
 
Note:
Any Taxpayer may file the Application for Compounding of Offence in the following two cases:

Prosecution is instituted: This means that an Order for initiation of prosecution has been issued against the Taxpayer. He/she would have received a Prosecution Notice,

issued by a concerned Tax Official, regarding the same.



Prosecution is contemplated: This means that the taxpayer is voluntarily filing this application for Compounding of Offence. A taxpayer can do so if he/she has received

an Order, issued by a concerned Tax Official, against any case involving commission of any offence specified in Section 132.
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications  
 

 
4. My Applications page is displayed. In the Application Type field, select "Compounding Application" and then click the NEW APPLICATION button.
 

http://www.gst.gov.in/


 
5. Compounding Application page is displayed. The Yellow header on the top contains the name of the application type and your information—GSTIN, Legal Name and
Registration Status. Click the BACK button to go to the previous page or enter details in the displayed fields as mentioned in the following steps.
 









 
5a. In the "Whether any order for initiation of prosecution has been issued?" field, select the "Yes" or "NO" radio button.
 
5a. (i) In case of "Yes" if any Order for initiation of prosecution has been issued: In the Prosecution Notice No. field, enter the Notice Number and click the SEARCH button. The
following fields get auto-populated: (Notice) "Date", "The violation of provisions of the Act for which prosecution is instituted or contemplated:", "Amount of evasion
involved, if any", "Period of Offence". Now, perform the Step 5e.
 
5a. (ii) In case of "No" if no Order for initiation of prosecution has been issued: In the "Any other order against which prosecution is contemplated?" field, enter the
Order/Reference Number and click the SEARCH button. (Order) Date gets auto-populated.  
5b. In the "The violation of provisions of the Act for which prosecution is instituted or contemplated:" field, select the applicable radio button(s). You can select more than
one radio button.
5c. In the "Amount of evasion involved, if any" field, enter the amount across the respective major and minor heads.
5d. In the "Period of Offence" field, select the "From" and "To" dates using the calendar.
5e. In the "Whether this is the first offence under the Act" field, select the "Yes" or "NO" radio button.
 
5e. (i). In case of "Yes" if this is the first offence under the Act: Perform the following Step 5f.
 
5e. (ii).In case of "No" if this is not the first offence under the Act: Enter the relevant details in the text-box in maximum 250 characters. Then, perform the following step.
 

 
5f. In the "Whether any proceedings for the same offence is contemplated under any other law" field, select the "Yes" or "NO" radio button.



 
5f. (i) In case of "Yes" if any proceedings for the same offence is contemplated under any other law: Enter the relevant details in the text-box in maximum 250 characters. Then,
perform the following step.
 

 
5f. (ii) In case of "No"if no proceedings for the same offence is contemplated under any other law: Perform the following Step 5g.
 
5g. If required, in the Upload Supporting Documents, if any field, you can also upload supporting documents. This is not a mandatory field. Enter document description and click
the Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by clicking the
DELETE button and upload again.
 



   

 
5h. In the Declaration field, select the two check-boxes.
5i. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.
 



 
5j. Click PREVIEW to download and review your application. Once you are satisfied, click the PROCEED TO FILE button.
 





 
5k. A Warning message is displayed. Click the PROCEED button.
 

 
6. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.
 



 
7. Acknowledgement page is displayed. To download the filed application, click the DOWNLOAD button or click Go To My Applications link go back to My Applications page.
 



 
Note:
 
Once the application is filed, following actions take place on the GST Portal:

Status of the application on the GST Portal gets updated to "Compounding Application Submitted".

You will also receive an intimation on your registered Mobile and email informing you of the generated ARN and successful filing of the application.

The Application will land in the concerned authority's queue and he/she will take subsequent actions on it.  

 



Go back to the Main Menu

B. Searching for your filed Application in "My Applications" Screen

To search for the submitted applications and open the related ARN on the GST Portal, perform following steps:
 
1. Access the www.gst.gov.in URL. The GST Home page is displayed.
2. Login to the portal with valid credentials.
3. Dashboard page is displayed. Click Dashboard > Services > User Services > My Applications  
 

http://www.gst.gov.in/


4. My Applications page is displayed. In the Application Type field, select "Compounding Application" from the drop-down list. Also select the submission period in the From
Date field and To Date field and then click SEARCH.
 

 
5. Based on your Search criteria, applications are displayed. Click the ARN/RFN hyperlink you want to open.
 



 
6. Case Details page is displayed. From this page, you can click on the tabs provided at the left-hand side of the page to view and download their related details.
 



 
Go back to the Main Menu

C. Take action using APPLICATIONS tab of Case Details screen: View your Filed Application

To view your filed Application Details, perform following steps:
 
1. On the Case Details page of that particular application, select the APPLICATIONS tab, if it is not selected by default. This tab provides you an option to view the filed
application, along with its supporting documents in PDF mode.
 



 
2. In the "View Documents column, click the "View" hyperlink to download and view the related document.
 
Go back to the Main Menu

D(1). Take action using NOTICES tab of Case Details screen: View Issued Notices

To view the Notices issued by the concerned Tax Official to you against your Application for Compounding of Offence, perform following steps:
 

1. On the Case Details page of that particular application, select the NOTICES tab, if it is not selected by default. This tab displays all the notices (Hearing Notice/Adjournment)

issued by the concerned Tax Official to you.

 



 

2. In the "Documents" column, click the document name(s) to download them into your machine and view them.

 
Go back to the Main Menu

D(2). Take action using NOTICES tab of Case Details screen: File Reply to the Issued Notice

To file reply to the Notices issued by the concerned Tax Official to you against your Application for Compounding of Offence, perform following steps:
 

1. On the Case Details page of that particular application, select the NOTICES tab, if it is not selected by default. This tab displays all the notices (Hearing Notice/Adjournment)

issued by the concerned Tax Official to you.



 

 

2. Select the radio button against the Notice for which you want to file your reply. The REPLY button gets enabled. Click the enabled REPLY button.

 



 

3. The REPLY page is displayed. The following fields are auto-populated—Name of the respondent, Notice Reference No, Date of communication of Notice. Enter details

in the other fields as mentioned in the following steps. To go to the previous page, click BACK.

 





 
3a. In the Details of Reply field, click Choose File to upload the document(s) related to your reply.
3b. If required, in the Upload Supporting Documents, (if any) field, you can also upload supporting documents. This is not a mandatory field. Enter document description
and click the Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by
clicking the DELETE button and upload again.
 

   



 
3c. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.
 

 
3d. Click the PROCEED button.
3e. A warning popup is displayed. Click the PROCEED button in the popup as well.



 
4. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.
 



 
5. Acknowledgement page is displayed with the generated Reply Reference number. Click the OK button.
 



 
6. The updated REPLIES tab is displayed, with the record of the filed reply in a table. Click the documents in the Documents section of the table to download them.
 

 
7. Once the Taxpayer files reply, following actions take place on the GST Portal:

ARN Status on the GST Portal gets updated to "Reply submitted".

All concerned Tax Officials will be intimated about the filed reply via their registered email.



Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following navigation: Services > User Services > My Applications >
REPLIES.

Dashboard of all the concerned Tax Official roles is updated with the record of the filed reply.

 
Go back to the Main Menu

E(1). Take action using REPLIES tab of Case Details screen: View Filed Replies  

To view the replies filed by you or the concerned Tax Officials against your Application for Compounding of Offence, perform following steps:
 

1. On the Case Details page of that particular application, select the REPLIES tab. This tab will display the replies that you or the concerned Tax Officials have filed on the

issued Notices.

 

 

2. In the "Documents" column, click the document name(s) to download them into your machine and view them.



 
Go back to the Main Menu
 

E(2). Take action using REPLIES tab of Case Details screen: File Counter-replies

To file counter- replies after a concerned Tax Official has filed reply against your Application for Compounding of Offence, perform following steps:
 

1. On the Case Details page of that particular application, select the REPLIES tab. This tab will display the replies that you or the concerned Tax Officials have filed on the

issued Notices. Select the radio button against the Reply for which you want to file your reply. The REPLY button gets enabled. Click the enabled REPLY button.

 

 

2. The REPLY page is displayed. Follow the steps you would have performed to file your reply to the issued Notices. Click here to revisit those steps.

 





 
3. Once the Taxpayer files a counter-reply, following actions take place on the GST Portal:

ARN Status on the GST Portal gets updated to "Reply submitted".

All concerned Tax Officials will be intimated about the filed reply via their registered email.

Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following navigation: Services > User Services > My Applications >
REPLIES.

Dashboard of all the concerned Tax Official roles is updated with the record of the filed reply.

 
Go back to the Main Menu

F(1). Take action using ORDERS tab of Case Details screen: View the Order Issued on that Application

To view and download the order issued on your Application for Compounding of Offence, perform following steps:
 
1. On the Case Details page of that particular application, click the ORDERS tab. This tab provides you an option to view the issued order, with all its attached documents, in
PDF mode. The concerned authority may grant or reject compounding.
 



 



 

2. In the "Documents" column, click the document name(s) to download them into your machine and view them.

 
Note1:  
 
Additionally, once the concerned authority issues an Order, following actions will take place on the GST Portal:
 

Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email informing them of the issued Order.

In case the concerned authority grants the application request: Status of the ARN willl get updated to "Compounding allowed".

In case the concerned authority rejects the application request: Status of the ARN will get updated to "Compounding Rejected" and the following actions will take place:

If the compliant has been filed with the Magistrate/Court of competent jurisdiction, no action will be taken and prosecution proceedings will continue.

If no compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax official will proceed with prosecution proceedings.

 
Note2:  
The concerned authority may, as per his/her discretion, withdraw Compounding at any stage during the processing of the Compounding Application. If he/she chooses to do so,
the status of the ARN shall get updated to "Compounding Withdrawn" and thereafter, no action could be performed, by the Taxpayer or the concerned Tax Officials, on the



withdrawn Application.
 
Go back to the Main Menu

F(2). Take action using ORDERS tab of Case Details screen: Pay Compounding Fee

To pay compounding fee in order to avoid further proceedings against you by the department, perform following steps:
 
Note:

You can pay Compounding Fee only when the concerned authority allows the application request by issuing "Compounding allowed" Order on your Application for

Compounding of Offence.

You need to pay the Compounding fee within 30 days of the Order, else the Order will become void.

You need to make payment of compounding fee through cash ledger only. ITC can be utilized for payment of tax only. Payment of taxes will be as per the rules applicable.

 
1. On the Case Details page of that particular application, click the ORDERS tab. Click the PAY FEE button below the table containing "Compounding allowed" Order.
 

 



2. Payment FEE page gets displayed with the table containing the Fee applicable as per the Act and the difference of amount which is available in your Cash Ledger versus the
amount required in Cash Ledger to pay the applicable fee . If "Amount required in Cash Ledger" column is not "Nil", click the "DEPOSIT IN CASH LEDGER" button to generate a
challan and deposit money in the Electronic Cash Ledger. Otherwise, click the "UTILIZE CASH" button to make payment using the cash present in your Electronic Cash Ledger.
 



 
Note: On clicking the "DEPOSIT IN CASH LEDGER" button, the challan page will get displayed. Click here to know how to generate challan and deposit cash in the cash ledger.
 

https://www.gst.gov.in/help/payments


3. On clicking the ""UTILIZE CASH" button, the Acknowledgement page gets displayed with the generated PRN. Click OK.
 

4. The updated Orders tab is displayed. Also, note that as you have now paid the compounding fee the "PAY FEE" button is disabled.
 

 
Note:
 
Once the Compounding Fee is paid, following actions take place on the GST Portal:

Status of the ARN will get updated to "Compounding Fee paid".



If the compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax official will withdraw the complaint.

If no compliant has been filed with the Magistrate/Court of competent jurisdiction, no prosecution proceedings willl be initiated.

 
Go back to the Main Menu

F(3). Take action using ORDERS tab of Case Details screen: Initiate Rectification

In case you notice an error apparent from the face of the order, you can file rectification application against the Compounding Order passed by the concerned authority.
 
Note:

You can submit the Application for rectification within <three months> from the date of Order sought to be rectified.

No rectification shall be allowed after a period of six months from the date of issue of such decision or Order and if the rectification is purely in the nature of correction of a

clerical or arithmetical error, the limitation of six months will not apply.
 
To initiate rectification, perform following steps:
 
1. On the Case Details page of that particular application, click the ORDERS tab. Select the radio button against the Order for which you want to initiate rectification. The
INITIATE RECTIFICATION button gets enabled. Click the enabled INITIATE RECTIFICATION button.
 



 
2. "Submission of Rectification request" page is displayed. The following fields are auto-populated—Order Reference No & Date of communication of Order. Enter details in
the other fields as mentioned in the following steps.
 





 
2a. In the Details of Rectification field, click Choose File to upload the document(s) containing details of the rectification that needs to be done.
2b. If required, in the Upload supporting documents field, you can also upload supporting documents. This is not a mandatory field. Enter document description and click the
Choose File button. ADD DOCUMENT button gets displayed. Click it to upload the document(s) from your machine. You can delete the uploaded document by clicking the
DELETE button and upload again.
 

   

 
2c. Enter Verification details. The "Designation/ Status" and "Date" fields is auto-populated based on the current system date.
 



 
2d. Click the PROCEED TO FILE button. A warning popup is displayed in case. Click PROCEED in the popup.
 



 
Note: In case the difference between the date of the Order and rectification application filed is more than 6 months, an information message shall pop up asking for confirmation
“Do you still want to file the Rectification application as the period exceeds 6 months from the date of the order”.
 
4. Submit Application page is displayed. Click SUBMIT WITH DSC or SUBMIT WITH EVC.
 



 
5. Acknowledgement page is displayed with the generated Reference number. Click the OK button.
 



 
6. The updated RECTIFICATION tab is displayed, with the record of the filed rectification application request in a table and the Status updated to "Rectification request
submitted". Click the documents in the Details of Rectification section of the table to download them.
 

 
Note:
 
Once a Rectification request is submitted by a Taxpayer, following actions take place on the GST Portal:

Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the submitted Rectification request.



Status of the ARN on the GST Portal gets updated to "Rectification request submitted".

 
Go back to the Main Menu

G. Take action using RECTIFICATION tab of Case Details screen: View the Filed Rectification Applications

To view the Rectification Applications filed by the Taxpayer or the concerned Tax Official, perform following steps:
 

1. On the Case Details page of that particular application, select the RECTIFICATION tab, if it is not selected by default. This tab displays all the rectification applications

submitted by you or the concerned Tax Officials.

 

 

2. In the "Details of Rectification" column, click the document name(s) to download them into your machine and view them.

 
Note:
Once a Rectification request is submitted by a Taxpayer, the concerned authority may either accept the request or reject it. However, in case the Order which need to be rectified
has the effect of enhancing the tax liability or reducing the amount of admissible input tax credit then, it cannot be passed unless the Applicant has been given an opportunity of



being heard.
 
In case of Acceptance:

The concerned authority issues the Rectification Order. Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. Taxpayer can

access the Rectification Order from the ORDERS tab.

Status of the ARN on the GST Portal gets updated to "Rectification order passed".

   
In case of Rejection:

The concerned authority issues the Order. Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. Taxpayer can access the

Order from the RECTIFICATION tab.

Status of the ARN on the GST Portal gets updated to "Rectification request rejected".

 
Go back to the Main Menu
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Demands and Recovery



Filing an Intimation of Payment
– Form GST DRC 03



Payment on Voluntary Basis (FORM GST DRC-03)

What is the facility for Payment on Voluntary Basis?
Payment on Voluntary Basis is a facility given to tax payers to make payment u/s 73 or 74 of the CGST Act, 
2017 within 30 days of issuance of Show Cause Notice (SCN). Payment could also be made by taxpayers 
before SCN is issued.

When can I make voluntary payment?
You can make voluntary payment before issue of notice u/s 73 or 74 of the CGST Act, 2017 or within 30 days of
issue of show cause notice (SCN) under the said sections. You cannot make voluntary payment after 30 days of
issue of SCN.

What are the pre-conditions to make voluntary payment?
The pre-conditions to make voluntary payment are:
a. In case, voluntary payment is made before issue of SCN
• Show Cause Notice under determination of tax should not have been issued.
b. In case, voluntary payment is made after issue of SCN or statement
• 30 days’ time has not lapsed since SCN is issued.



Payment on Voluntary Basis (FORM GST DRC-03)

How can I make voluntary payment?
To make voluntary payment against the liability (tax, interest & penalty) based on self-ascertainment of tax, navigate 
to Services > User Services > My Applications > Intimation of Voluntary Payment - DRC - 03 option.

Can I make partial payment against a liability raised in a SCN?
GST Portal does not allow for making partial payments against a liability raised in a SCN. Complete payment of the
amount being demanded in SCN has to be made.

When would a taxpayer need to select “Liability mismatch- GSTR-1 to GSTR-3B” and “ITC Mismatch- GSTR-
2A/2B to GSTR-3B” as cause of payment while making payment under “Intimation of Voluntary Payment-DRC-
03”?
Taxpayer needs to select “Liability mismatch- GSTR-1 to GSTR-3B” as cause of payment, when there is a liability 
mismatch between Form GSTR-1 and Form GSTR-3B and taxpayer is making payment of such liability using Form 
DRC-03.
Taxpayer needs to select “ITC Mismatch- GSTR-2A/2B to GSTR-3B” as cause of payment, when there is ITC 
mismatch between Form GSTR-2A/2B and Form GSTR-3B and taxpayer is making payment of such liability arising 
using Form DRC-03.
These are additional reasons made available under Intimation of Voluntary Payment-DRC-03 for taxpayers for 
making payments for liabilities noticed later on. The navigation to make such payment is Services > User 
Services > My Application > Application Type > Select Intimation of Voluntary Payment-DRC -03, Click New 
Application > select Cause of Payment.



Payment on Voluntary Basis (FORM GST DRC-03)

What will happen on filing of Form GST DRC-03?
Electronic Liability Register, Electronic Cash Ledger and Electronic Credit Ledger will be updated upon filing of 
Form GST DRC-03 i.e. Debit/Credit (both) entry will be posted simultaneously and PRN will be generated 
accordingly.

I don't have sufficient balance to make payment against a liability raised in a SCN. What do I do now?
You can deposit the amount in Electronic Cash Ledger through "Create Challan" functionality which is available on 
voluntary payment screen. On click of "Create Challan" button, you will be redirected to Create Challan screen in 
Payment module. In the Create challan page, challan amounts will be auto-populated based on the amount of 
additional cash required considering the tax liabilities and others.

Can I save the application for intimation of voluntary payment?
Application for intimation of voluntary payment can be saved at any stage of completion for a maximum time 
period of 15 days. If the same is not filed within 15 days, the saved draft will be purged from the GST 
database. To view your saved application, navigate to Services > User Services > My Saved
Applications option.



Applying for Deferred Payment 
or Payment in Instalments 

(FORM GST DRC - 20)



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

What is the purpose of FORM GST DRC - 20?
FORM GST DRC - 20 is an application form that can be filed by any taxpayer to apply for one of the following 
two options available to him in case he cannot pay the entire amount due under the GST Act in one go: 
Deferred payment: when dues are deferred for payment at later stage
Payment in instalments: when due is paid in installments over a period of time

When can I file FORM GST DRC - 20?
You can file FORM GST DRC - 20 when a demand is pending for recovery under GST Act against you and you
wish to apply for deferred payment or payment in instalments of amount due under the GST Act.
You are required to have valid login credentials to file this application.

Can I file FORM GST DRC - 20 in respect of amount against return related demands?
No, application for deferred payment using FORM GST DRC - 20 cannot be filed against return related 
demands. You can file application for deferred payment using FORM GST DRC - 20 for other than return 
related demands, which are posted in Electronic Liability Register Part-B.

How many applications for deferred/payment in Instalments can I file?
Only one “Application for Payment in Instalments” can be submitted against a particular Demand ID.



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

In FORM GST DRC - 20, I need to enter the number of months for my instalments. Is there any limitation on 
the number of months?
Yes. Maximum number of instalments allowed is 24.

How is the interest calculated if I select the option of "Monthly Instalments" in FORM GST DRC - 20?
Interest is calculated considering the following points:
Interest will be applicable only on the tax/cess amount applied for instalment/deferment. 
No interest will be payable on the Interest, Penalty and any other amount in the Demand ID.
Interest will not be calculated by system as part of application for deferred payment/payment in instalment. 
Instead, if any interest needs to be recovered from taxpayer as part of monthly instalment then tax officer 
will create separate demand ID which will be paid by taxpayer.

What will happen if I am unable to make the required payment, after the acceptance of my application for 
payment in Instalments?
In case there is any default in payment of any one installment on its due date, the whole outstanding balance 
payable on such date will become due and payable forthwith, and will be liable for recovery without any 
further notice to the Taxpayer.



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

I have filed FORM GST DRC - 20. What actions will take place on the GST Portal now?
Once you have filed FORM GST DRC - 20, following actions will take place on the GST Portal:
GST Portal will generate and display Application Reference Number (ARN) receipt with an option to”Save and
Print” the same.
SMS and Email will be sent to you intimating ARN and successful filing of the Form.
Your application for payment in Installments shall be submitted to the Commissioner/proper officer of concerned 
jurisdictional authority and will become a pending item in his/her queue of work-items. The Officer will 
adjudicate on the application and either Accept or Reject or Accept with modification your request. You can 
access the generated ARN and view the filed application from the following navigation: Dashboard > Services > 
User Services > My Applications > Case Details > APPLICATIONS
Demand ID in DCR, in respect of which you have filed this application, will be flagged to show that such an 
application is filed against the Demand ID.

What is an Instalment Calendar?
Instalment Calendar displays the taxpayer's instalment details to be paid by him along with status of payments.

From where I can view the Instalment Calendar?
Navigate to Services > Payments > Instalment Calendar to view the Instalment Calendar.



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

How will I come to know that the officer has processed my application for deferred/payment in 
Instalments?
Once the officer has processed an application for deferred/payment in Instalments, following actions will
take place on the GST Portal:
Approval or Rejection or Modification order will be generated and intimation of issue of order shall be sent 
via email and SMS to taxpayer.
Status of ARN shall get updated to ‘Rejected’ in case of rejection, "Approved" in case of acceptance and 
“Application approved with modification” in case of modification.
Order will be available at the dashboard of taxpayer for view, print and download:
Dashboard > Services > User Services > My Applications > Case Details > ORDERS
Status of Recovery ID remains the same in case of rejection. In case of acceptance or modification, the 
status of recovery ID shall change to “Deferred Payment/Payment by Instalments”. If there is a default in 
the payment of monthly instalments, the status of recovery ID shall change from Deferred 
Payment/Payment by Instalments to Recoverable



Applying for Deferred Payment or Payment in Instalments (FORM GST DRC - 20)

During the processing of applications for deferred payment or payment in instalments, what all and 
when the Status changes take place in an ARN/Case ID on the GST Portal?
On the GST Portal, during the processing of applications for deferred payment or payment in instalments,
the ARN/Case ID may undergo following Status changes:

• Pending for Processing: When a taxpayer files the application and it is under work item of tax officer
• Approved: When tax officer approves the application of taxpayer for deferred payment or payment in

instalments
• Application approved with modification: When tax officer approves the application with certain 

modifications
• Rejected: When tax officer rejects the application of taxpayer for deferred payment or payment in 

instalments
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Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

When recovery process in GST Portal/ law is initiated?
Recovery process in GST Portal is initiated under following conditions:
• Demand ID is created under Assessment, Enforcement, Appeal, Refund or any other module and is reflected in

the Electronic Liability Register.
• Prescribed time under the GST law for making the payment of adjudged dues has expired i.e., Recovery against 

demand is not stayed by any competent authority,
• Demand is in recoverable stage, not within appeal period, finally adjudged, or appeal not filed against the

order/appellate order ( i.e. order via which demand is confirmed).

What are the various modes of recovery process?
In GST regime, where any sum is payable by the taxpayer on account of scrutiny, assessment, enforcement, 
adjudication and appeal process, and remains unpaid, the tax authorities would initiate the recovery process by 
adopting any of the following modes as provided in the GST laws. Some of the modes are -
 Detaining and selling of goods of the taxpayer in the possession of the tax department/ other officer
 Issuance of letter / correspondence to third parties including banks / any other government departments/ 

debtors/ any other person provided in law/ successor or transferee or legal heir
 Distrain, detain and sell immovable and movable property
 Issuance of certificate to revenue authorities for recovery as arrears of Land Revenue
 Application to magistrate to recover as fine
 Recovery from Electronic Cash Ledger/ Electronic Credit Ledger of a taxpayer
 Any other mode as prescribed under law



Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

What type of notices can be issued?
Based on Mode of Recovery selected, relevant notice type can be issued. The table below provides the list of 
notice types which can be issued based on mode of recovery.

Mode of Recovery Notice Type

Sale of taxable goods in control of 
Recovery officer

FORM GST DRC - 10 (Notice for Auction of Goods under section 79
(1) (b) of the Act)

Notice to Third Parties

FORM GST DRC - 13 (Notice to a third person under section 79(1) (c)) 
FORM GST DRC - 15 (Application before the Civil Court requesting 
execution for a Decree)

Attachment/Seizure of 
Immovable/Movable properties by Tax 
Authorities

FORM GST DRC - 16 (Notice for attachment and sale of
immovable/movable goods/shares under section 79)
FORM GST DRC - 22 (Provisional attachment of property under 
section 83)

Application to Magistrate for recovery 
as Fine

FORM GST DRC - 19 (Application to the Magistrate for Recovery as 
Fine)

Notice to Specified Officer
FORM GST DRC - 09 (Order for recovery through specified officer 
under section 79)



Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

What type of certificates/ orders can be issued?
Based on Mode of Recovery selected, relevant certificate/ order type can be issued. The table below provides 
the list of certificate/ order type which can be issued based on mode of recovery.

Mode of Recovery Notice Type

Sale of Taxable Goods in control of 
Recovery officer

FORM GST DRC - 12 (Sale Certificate)

Notice to Third Parties FORM GST DRC - 14 (Certificate of Payment to a Third Person)

Attachment/Seizure of Immovable/ 
Movable properties by Tax Authorities

FORM GST DRC - 12 (Sale Certificate)
FORM GST DRC - 23 (Restoration of provisionally attached property / 
bank account under section 83)

Issuance of Certificate to Revenue 
Authorities

FORM GST DRC - 18 (Certificate action under clause (e) of sub-
section (1) section 79)

Recovery from other state
FORM GST DRC - 18 (Certificate action under clause (e) of sub-
section (1) section 79)



Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

Do I get any intimation about the notice or order issued?
Navigate to Services > User Services > View Additional Notices/ Orders to view any notification. You will not 
receive any intimation through Email or SMS.

From where can I view notice issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View > NOTICES option.

From where can I reply to notice issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View > REPLIES option.

From where can I view rejection order issued for recovery of taxes?
Navigate to Services > User Services > View Additional Notices/ Orders > View >CERTIFICATES/ ORDERS option.



Filing reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes

Do I get any intimation once a Tax Official utilizes the amount from my Electronic Credit/Cash Ledger to
make recovery of the taxes?
Intimation is sent to the taxpayer via SMS and E-mail once a Tax Official utilizes the amount from your 
Electronic Credit/Cash Ledger to make recovery of the taxes.

What will happen once I file reply to Form GST DRC-22, against proceedings initiated for Recovery of Taxes ?

Once you file your reply successfully, following actions take place on the GST Portal:
You will receive an acknowledgement intimation via your registered email and SMS, along with the generated 
RFN.
Your reply will be available on Tax Official's dashboard.
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Viewing Pre-GST Demand Uploaded by Tax Official (Form GST DRC-07A & GST DRC-08A)

What is Form GST DRC-07A?
If any demand (Tax, interest, penalty, fees or any other dues) was created under Pre-GST laws (e.g. State VAT / 
CST / Central Excise / Service Tax etc.) and is not recovered under those laws, then it can be recovered as 
arrears of GST, under GST Act.
The summary of such pre-GST demand will be issued/uploaded in Form GST DRC-07A by Recovery officer on

the GST Portal and the demand will be posted in Part II of Electronic Liability Register of the taxpayer.

What is Form GST DRC-08A?
Where a pre-GST demand order, uploaded via Form GST DRC-07A is rectified or modified or quashed in any 
proceedings, including that in appeal, review or revision, or the recovery is made under the existing laws, a 
summary of such order will be uploaded in FORM GST DRC-08A. Accordingly, Part II of Electronic Liability 
Register will also be updated.

Where can I view Form GST DRC-07A issued to me?
To view Form GST DRC-07A, navigate to
Services > User Services > View Additional Notices and Orders > View > DRC-07A.

Where can I view Form GST DRC-08A issued to me?
To view Form GST DRC-08A, navigate to
Services > User Services > View Additional Notices and Orders > View > DRC-08A.



Viewing Pre-GST Demand Uploaded by Tax Official (Form GST DRC-07A & GST DRC-08A)

Does a taxpayer get any intimation about Form GST DRC-07A or Form GST DRC-08A issued to him?
Taxpayer will get intimation of issue of Form GST DRC-07A/ Form GST DRC-08A issued to him/her, though SMS 
and e-mail.

What are the various tabs available in case details page?
Two clickable tabs - DRC-07A and DRC-08A are available in case detail page.
• DRC-07A: To view details of the DRC-07A issued by Tax Official
• DRC-08A: To view details of the DRC-08A issued by Tax Official

How can I make payment against the pre-GST demand issued by Tax Official?
To make payment against the pre-GST demand issued by Tax Official, navigate to Services > Ledgers > Payment 
towards Demand option.

What are the various Status types for searching a pre-GST Recovery Case ID on the Search Screen?
Various status types of a pre-GST Recovery Case ID are:

Status of Case ID Action that Results in this Status

DRC-07A issued When Form GST DRC-07A is issued by Recovery Officer

DRC-08A issued When Form GST DRC-08A is issued by Recovery Officer



Prosecution and 
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Viewing Prosecution Notice 
Issued by Tax Officials



Viewing Prosecution Notice Issued by Tax Officials

What are Prosecution Proceedings?
Prosecution Proceedings are instituted against the taxpayers who are involved in cases of tax evasion beyond 
the specified limit and for which penal actions are applicable on specific events subject to certain conditions 
with varied quantum of punishments. Some of the offences are compoundable while some others are not.
Prosecution actions include filing of private complaint based on facts which constitute an offence (under the 

GST law) for initiation of criminal proceedings, when the Tax official has reason to believe that any person 
has committed any of the offences under provisions of GST law. (For details, refer Section 132 of the 
CGST/SGST Act)

What are the steps involved in Prosecution Proceedings?
Following steps are involved in Prosecution Proceedings:

1.After taking due sanction from the Commissioner, the Tax Official files a Private Complaint (offline) against 
the Taxpayer, with the First Class Judicial Magistrate/Court.
2.Tax Official issues the Prosecution Notice against the Taxpayer. Intimation of the issue of Notice is sent to 
the concerned taxpayer on his/her registered email id and mobile. Dashboard of the Taxpayer is also 
updated with the record of the issued Notice. He/she can view the issued Notice from the following 
navigation: Services > User Services > View Additional Notices/Orders.



Viewing Prosecution Notice Issued by Tax Officials

In what cases, can a Prosecution Complaint against me be closed?
The Prosecution Complaint against you can be closed in the following cases:
• If you file the application for compounding of offence and the same is allowed by the Commissioner and 

the compounding amount (tax, interest and penalty involved) is also paid by you within the time 
specified in the Order, then the private complaint filed with the First Class Judicial Magistrate or 
Competent Court will be withdrawn/stand abated. (for details refer Section 138)

• If you file the application for compounding of offence and the same is allowed by the Commissioner and 
the compounding amount is paid by you within the time specified in the Order, but the private 
complaint is not yet filed with the First Class Judicial Magistrate or Competent Court, then no further 
action shall be taken for prosecution in respect of same offence.

• If the private complaint filed with the First Class Judicial Magistrate or Competent Court is set aside, 
then the case stands closed.

• If you have complied with the order of the First Class Judicial Magistrate or Competent Court, then the
case stands closed.

During Prosecution Proceedings, what all Status changes does the Case undergo?
During Prosecution Proceedings, the Case undergoes following Status changes:
• Complaint filed: When details of prosecution complaint is uploaded by the Tax Official.
• Closed: When status of complaint is updated as closed by the Tax Official.
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Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What is the purpose of Form GST CPD-01?
Form GST CPD-01 is Application for Compounding of Offence. Any Taxpayer can file this application in the 
following two cases:
• Prosecution is instituted: This means that an Order for initiation of prosecution has been issued against 

the Taxpayer. He/she would have received a Prosecution Notice, issued by a concerned Tax Official, 
regarding the same.

• Prosecution is contemplated: This means that the taxpayer is voluntarily filing this application for 
Compounding of Offence. In this case, he/she might have received a Prosecution Notice or an Order, 
issued by a concerned Tax Official.

When can I file Form GST CPD-01-Application for Compounding of Offence?
Any Taxpayer may file the Application for Compounding of Offence in the following two cases:
• Prosecution is instituted: This means that an Order for initiation of prosecution has been issued against 

the Taxpayer. He/she would have received a Prosecution Notice, issued by a concerned Tax Official, 
regarding the same.

• Prosecution is contemplated: This means that the taxpayer is voluntarily filing this application for 
Compounding of Offence. A taxpayer can do so if he/she has received an Order, issued by a concerned Tax 
Official, against any case involving commission of any offence specified in Section 132.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What is the general process of conducting Compounding Proceedings on GST Portal?
General process of conducting Compounding Proceedings on GST Portal is:
1. The Taxpayer files Application for Compounding of Offence (Form GST CPD-01) on the GST Portal.
2.The concerned authority examines the Application for Compounding of Offence filed by the Taxpayer with 
reference to the provisions and may issue Hearing Notice to the Prosecution and Compounding Officer or 
Taxpayer or both before disposing the application.
3. The Taxpayer can file reply to the issued Notice or can appear on the day of the scheduled hearing.
4. On the date of hearing, party(ies) appear before the concerned authority. The concerned authority can also
issue an Adjournment Notice to the party(ies) with details of new date, new place and new time of hearing.
5.After conducting hearing and examining the application and the related documents received during hearing, if 
any, the concerned authority will issue an Order either allowing or rejecting the application for Compounding.
6. The Taxpayer or the Prosecution and Compounding Officer may, if required, file for rectification of the issued
"Compounding allowed" Order.
7.If required, the concerned authority may also do a Suo-moto rectification of the issued "Compounding 
allowed" Order. No rectification can be done after a period of six months from the date of issue of such decision 
or order. However, if the rectification is purely in the nature of correction of a clerical or arithmetical error, 
limitation of six months will not apply.
Note: The concerned authority may, as per his/her discretion, make a suo-moto withdrawal of the Compounding 

Application at any stage, once it has been filed by the Taxpayer.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What happens on the GST Portal once the Form GST CPD-01 is filed by a Taxpayer?
Once the Form GST CPD-01 is filed, following actions take place on the GST Portal:
Dashboard of Taxpayer and the concerned Tax Official(s) is updated with the record of the filed Application. 
Status of the application on the GST Portal gets updated to "Compounding Application Submitted".
Taxpayer will also receive an intimation on his/her registered Mobile and email ID informing about the
successful filing of the application and the generated ARN.
The Application will land in the concerned authority's queue and he/she will take subsequent actions to 
process it.

What happens on the GST Portal once a Reply is filed by a Taxpayer?
Once the Taxpayer files a reply or a counter-reply, following actions take place on the GST Portal:
ARN Status on the GST Portal gets updated to "Reply submitted".
The concerned Tax Official(s) will be intimated about the filed reply via their registered email.
Dashboard of the Taxpayer is updated with the record of the filed reply. He/she can view it from the following 
navigation: Services > User Services > My Applications > REPLIES.
Dashboard of all the concerned Tax Official roles is updated with the record of the filed reply.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What happens on the GST Portal once the concerned authority allows the application for compounding?
Once the concerned authority allows the application for compounding, following actions take place on the
GST Portal:
Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. 
Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email 
informing them of the issued Order.
Status of the ARN will get updated to "Compounding allowed".

What happens on the GST Portal once the concerned authority rejects compounding?
Once the concerned authority rejects compounding, following actions take place on the GST Portal: 
Dashboard of Taxpayer and the concerned Tax Officials is updated with the record of the issued Order. 
Taxpayer and the concerned Tax Official will receive an intimation on their registered Mobile and email 
informing them of the issued Order.
Status of the ARN shall get updated to "Compounding Rejected"

Once the concerned authority has allowed application for compounding, can he/she withdraw it?
Yes. After allowing Compounding, authority may also withdraw it, at any stage if he is satisfied that such 
person, had, in the course of the compounding proceedings, concealed any material particulars or had given 
false evidence. In this case status of the ARN shall get updated to "Compounding Withdrawn" and thereafter, 
no action could be performed by the Taxpayer or the concerned Tax Officials, on the withdrawn ARN.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What are the points I need to know before making payment of the Compounding Fee?
Before you make the payment of the Compounding Fee, you should be aware of the following points:
You are required to pay tax, interest and penalty liable to be paid for which the application has been made. 
You can pay Compounding Fee only when the concerned authority allows the application request.
You need to pay the Compounding fee within 30 days of the Order, otherwise, the Order will be vitiated and be 
void.
You need to make payment of compounding fee through cash ledger only. ITC can be utilized for payment of tax 
only. Payment of taxes will be as per the rules applicable.

What happens once the Compounding Fee is paid?
Once the Compounding Fee is paid, following actions take place on the GST Portal: 
Status of the ARN gets updated to "Compounding Fee paid".
If the compliant has been filed with the Magistrate/Court of competent jurisdiction, the concerned Tax 
official will withdraw the complaint.
If no complaint has been filed with the Magistrate/Court of competent jurisdiction, no further prosecution
proceedings shall be initiated.

I do not have sufficient amount in my Cash Ledger. How can I pay the Compounding Fee?
If you do not have sufficient amount in my Cash Ledger, you can create a Challan to deposit money in the Electronic 
Cash Ledger. You can easily do so by clicking the "DEPOSIT IN CASH LEDGER" button available on the Payment FEE 
page.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

Can I submit a Rectification request against the Compounding Order issued by the concerned authority? 
Yes. in case you notice an error apparent from the face of the order, you can file rectification application 
against the Order passed by the concerned authority.
Additionally, note that:
• You can submit the Application for rectification within <three months> from the date of Order sought 

to be rectified.
• No rectification shall be allowed after a period of six months from the date of issue of such decision or 

Order.
• If the rectification is purely in the nature of correction of a clerical or arithmetical error, the limitation 

of six months shall not apply. Thus, in this case (when the difference between the date of the Order and 
rectification application filed is more than 6 months), the following information message pops up 
asking for confirmation “Do you still want to file the Rectification application as the period exceeds 6 
months from the date of the order”. You can click the PROCEED button to move forward with filing the 
application.



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

What happens on the GST Portal once a Rectification request is submitted by a Taxpayer?
Once a Rectification request is submitted by a Taxpayer, the concerned authority may either accept the 
request or reject it. However, in case the Order which need to be rectified has the effect of enhancing the 
tax liability or reducing the amount of admissible input tax credit then, it cannot be passed unless the 
Applicant has been given an opportunity of being heard.

• In case of Acceptance:
 The concerned authority issues the Rectification Order. Dashboard of Taxpayer and the concerned Tax 

Officials is updated with the record of the issued Order. Taxpayer can access the Rectification Order 
from the ORDERS tab.

 Status of the ARN on the GST Portal gets updated to "Rectification order passed".

• In case of Rejection:
 The concerned authority issues the Order. Dashboard of Taxpayer and the concerned Tax Officials is 

updated with the record of the issued Order. Taxpayer can access the Order from
the RECTIFICATION tab.

 Status of the ARN on the GST Portal gets updated to "Rectification request rejected".



Filing Application for Compounding of Offence (Form GST CPD-01) and Taking Actions in 
the Subsequent Proceedings

During the Compounding Application proceedings, what all Status changes does an ARN undergo?
During the Compounding Application proceedings, an ARN undergoes following Status changes:

• Compounding Application Submitted: When the Compounding Application is successfully filed by the Taxpayer
• Hearing notice issued: When hearing is issued to the Taxpayer or the P&C Officer or both
• Reply Submitted: When anyone (P&C Senior Officer/Assistant to Commissioner/P&C Senior Officer/Taxpayer) files 

reply to the issued notice or a counter-reply
• Adjournment granted: When adjournment notice is issued (by the P&C Senior Officer/Assistant to Commissioner) 

to the Taxpayer or the P&C Officer or both
• Compounding allowed: When the application for Compounding of offense is allowed by the P&C Senior

Officer/Assistant to Commissioner and order for compounding is issued
• Compounding Rejected: When the application for Compounding of offense is rejected
• Compounding Withdrawn: When the application for Compounding of offense is withdrawn by the P&C Senior 

Officer/Assistant to Commissioner
• Rectification request submitted: When application for Rectification of an issued Order ("Compounding granted"

Order or "Compounding Rejected" Order) is filed by the Taxpayer or the P&C Officer
• Rectification request rejected: When application for Rectification of an issued Order ("Compounding granted" 

Order or "Compounding Rejected" Order) is rejected by the P&C Senior Officer/Assistant to Commissioner
• Rectification order passed: When the Order is rectified by the P&C Senior Officer/Assistant to Commissioner
• Compounding fee paid: When the Taxpayer utilizes cash from the Electronic Cash Ledger to pay compounding fee
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Prosecution and Compounding of Offences– Sec 134, 135, 136& 137

COGNIZANCE OF OFFENCES [ Sec 134 ]

 Courts inferior than Magistrate of the First Class shall not declare the judgment for any
offence committed under this act .

PRESUMPTION OF CULPABLE MENTAL STATE [ Sec 135 ]

 Any offence under this act will be presumed to be done in a culpable mental state by
the court.

 However, the accused can defend himself by proving the fact he was not in such mental
state.

 A fact is said to be proved only when the court believes it to exist beyond reasonable
doubt and not merely when its existence is established by a preponderance of
probability.



Prosecution and Compounding of Offences– Sec 134, 135, 136& 137

RELEVANCY OF STATEMENTS UNDER CERTAIN CIRCUMSTANCES [ Sec 136 ]

A statement signed by a person during the course of proceeding is relevant for proving 
the truth of the facts in any prosecution for an offence under this act.

 When the person who made the statement is :

o Dead or cannot be found

o Incapable of providing evidences

o Restricted by the adverse party

o Presence of the person requires time or expenses involved for presenting the person, 
is considered unreasonable by the court .

 When the person who made the statement is considered as a witness by the court ,
the statement should be produced as a evidence in interest of the justice.



Prosecution and Compounding of Offences– Sec 134, 135, 136& 137

OFFENCES BY COMPANIES [ SEC 137 ]

• Offence committed by a company

• Every person who at the time of offence being committed was responsible for
the conduct of the business of the company shall be deemed to be guilty .

• Proceedings shall be conducted accordingly.

• If proved that the offence was committed with the consent of the key
managerial persons or negligence on their part , they shall also be deemed to
be guilty.



Prosecution and Compounding of Offences– Sec 134, 135, 136& 137

 Offence by Partnership Firm or LLP or a HUF or a Trust

• The partners or karta or the managing trustee shall be deemed to guilty for offence 
committed under this act.

• If proved the offence was committed without their knowledge or measures were
exercised to stop such offence then they shall not be held liable



Compounding of Offences – Sec 138

Compounding not available in following circumstances:

Compounding already allowed one time in respect of certain specified offences

Compounding allowed once shall not be allowed again if in previous  
compounding, value of supplies > Rs. 1 Crore in offences not specified above

A person accused of committing any offence under this act which is an offence 
under any other law

A person convicted for an offence under this act by a court

A person who obstructs any officer discharging duty, tampers material evidence, 
fails to supply or supplies false information



Compounding of Offences – Sec 138

General Rules regarding Compounding -

Compounding not to affect proceedings instituted under any other law

Compounding shall be allowed only after payment of taxes, interest, penalty for 
such offence has been made.

Minimum Compounding amount = Rs. 10,000/- or 50% of tax involved  
whichever is higher

Maximum compounding amount = Rs. 30,000/- or 150% of tax involved
whichever is higher

Upon payment, no further proceedings will be initiated and the accused person will 
stand abated



Compounding of Offences – Sec 138

Procedure for Compounding -

Application shall be made to the Commissioner in - GST CPD – 01

The Commissioner shall ask the concerned officer to furnish relevant 
documents

On satisfaction the Commissioner by order in FORM GST CPD - 02

Allow the application indicating 
the compounding amount and 

grant him immunity
from prosecution

Else he may reject it 
within 90 days of 

receipt.



Compounding of Offences – Sec 138

Procedure for Compounding -

Compounding shall be allowed only after payment of taxes, interest and penalty 

Compounding amount shall be paid within 30 days from the date of receipt of order

Failure to pay the compounding amount shall lead to order being void 

Immunity granted may be withdrawn anytime in case any material facts was concealed

by the applicant
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